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The distance between two points is a property of their spatial relationship. We can, for example, use 
the distance between two cities to estimate the cost and time needed to fly between them.  Because 
distance matters, how we measure distance also matters. The distance between two points can be 
calculated from their coordinates (Eq. 1)(Bolstad, 2017: p119, 174, 399, 470, 530, 626, 629, and 
687)(Kimmerling et al., 2012: Chapter 11). 

 

𝑫𝒊𝒔𝒕𝒂𝒏𝒄𝒆1→2 = √(𝒙2 − 𝒙1)2 + (𝒚2 − 𝒚1)2    Eq. 1 
 

where: 
 1, 2   a counter {from point 1, to point 2} 
 x   the x or easting value 
 y  the y or northing value 
 Distance the Euclidean distance between two points 

 
 
Using Eq. 1, the length of a line composed of multiple segments can be calculated if we know: a) how 
many vertices define the line; and b) the coordinates of those vertices (Equation 2). 
 

𝑺𝒉𝒂𝒑𝒆𝑳𝒆𝒏𝒈𝒕𝒉1→𝑛 = ∑ √(𝒙𝑖+1 − 𝒙𝑖)2 + (𝒚𝑖+1 − 𝒚𝑖)2𝑛
𝑖=1   Eq. 2 

 

where: 

 i   a counter {from vertex 1, ... , to vertex n} 
 x   the x or easting value  
 y  the y or northing value 
 shapeLength the calculated distance, or length, of a line 

 
 
The area of a polygon also can be calculated if we know: a) how many vertices define its perimeter; 
and b) the coordinates of each vertex (Equation 3).   
 

𝑺𝒉𝒂𝒑𝒆𝑨𝒓𝒆𝒂1→𝑛 =
1

2
∑ [ (𝒙1 × 𝒚𝑖+1) − (𝒙1+1 × 𝒚𝑖) ]𝑛

𝑖=1       Eq. 3 
 

where: 

 i   a counter {from vertex 1, … , to vertex n} 
 x   the x or easting value 
 y  the y or northing value 
 ShapeArea the calculated area of the polygon  
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Using Shape_Area 
The US Census Bureau produces an official count of the US population every ten years (years ending 
with zeros) and it samples the population to build inter-census estimates. Census counts and survey 
estimates are then aggregated up to the county, state, and national levels for people to use.   

Calculating the population density for a county is simple (Equation 4). You need an accurate 
population value (either a count or an estimate) and an accurate area value (usually in sq.mi or 
sq.km).  The US Census Bureau publishes reliable population data, but we have to use our GIS 
correctly to make sure our county areas are just as reliable.  
 

𝑷𝒐𝒑𝑫𝒆𝒏𝒔𝒊𝒕𝒚𝑖 =
𝒑𝒐𝒑𝑖

𝑺𝒉𝒂𝒑𝒆𝑨𝒓𝒆𝒂𝑖
      Eq. 4 

where: 

 i   a counter {county 1, county 2, county 3, …, county n} 
 pop   the population count or estimate for county i 
 ShapeArea the area of county i     (see Eq. 3) 
 PopDensity the population density value to be calculated 

 
 
############## 
I’m showing you the methods used to calculate shape lengths (Eq. 2) and shape areas (Eq. 3) because 
I need you to understand that each method relies on each shape’s coordinates only.  No other 
variables are used to calculate Shape_Length or Shape_Area.   
 
Ideally, when the geographic coordinates of two points are projected onto a flat mapping system, 
we want their flat map properties to mimic their geodesic properties (i.e., planar distance = geodesic 
distance). Unfortunately, it is impossible to preserve every geodesic distance between every pair of 
points during projection – especially when projecting hundreds or thousands of points over large 
extents.  Some pairs of points will project farther apart then they should; the distorted lengths and 
areas we calculate from such coordinates will be inflated.  Some pairs of points will project closer 
together than they should; the lengths and areas we calculate from those coordinates will be 
deflated.  Projection distortions can propagate as errors in subsequent calculations (e.g., in Eq. 4). 
 
############## 

The purpose of this lab is threefold: a) to help you develop a working knowledge of our national 
geographic coordinate system; b) to help you develop a working knowledge of commonly used 
planar mapping systems; and c) to help you understand how projecting geographic coordinates onto 
those planar mapping systems can create nasty distortions that lurk in your projected data.  Take 
your time and take good notes.  Work carefully and ask questions. 
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Obj. 1.  Get familiar with the geospatial data you downloaded 
The data you need for this lab is available on the course website. 
 

https://webspace.ship.edu/sadrzy/geo363/  

 
For this lab, we’re going to use a copy of the Census Bureau’s 1:500,000 (500K) scale Cartographic 
Boundary Shapefiles  for US counties (less AK and HI). I added two text fields to the county 
polygon attribute table so that you can see which county fits within which zone of the US State Plane 
mapping system (see Kimmerling et al., 2017; Fig. 4.5 on p67)(see Bolstad, 2016; p684). 
 We’re also going to use two shapefiles that I created, which represent the direct connections 
to and the airports that are reachable via Harrisburg International Airport. 
 
 

 
 
Figure 1. A stylized map of routes from Harrisburg International Airport to twelve destinations (last 
updated in November 2018). 
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Open your ArcGIS Pro project and use Catalog mode.  The default metadata view is limited.  Use 

Project > Options > Metadata and change the default view style to the FGDC Metadata style. 
 
 
 
Use Catalog mode to find your airports shapefile - airports.shp: 
 

1. Inspect your Metadata. 
2. Inspect your point Geography; and 
3. Inspect your attribute Table. 

 
Question 1: According to the attribute table, which three airports are the northernmost airports? 
 
 
Find your direct routes shapefile - directRoutes.shp: 
 

1. Inspect your Metadata. 
2. Inspect your polyline Geography; and 
3. Inspect your attribute Table. 

 
 

Question 2: According to the metadata, what is the geographic extent covered by these data?  
Report your answer using both the given DD and the DMS format for geographic coordinates. 
 
 
Find your US county shapefile - cb_2016_us_county_500k.shp: 
 

1. Inspect your Metadata. 
2. Inspect your polygon Geography; and 
3. Inspect your attribute Table. 

 
 
Question 3: According to the metadata, what is the geographic extent covered by your county data?  
Report your answer using both the given DD and the DMS format for geographic coordinates. 
 
 
 
Question 4: If you had a question about these county shapefile data that cannot be answered by 
looking at the metadata, then how would you contact the responsible party by phone or email?   
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Obj. 2. Convert your data from shapefile format to geodatabase format. 
 
Use Export > Feature class to feature class to export the polygons in your 
cb_2016_us_county_500k.shp shapefile into new polygon features in your geodatabase. 
Name your output feature class county.   
 
When data are saved into a geodatabase, polygon perimeter (Shape_Length, Eq.2) and area 
(Shape_Area, Eq.3) values are calculated automatically for polygons.  Add your geodatabase 

polygon feature class as a layer to your Map for previewing data map. 
 
 
Question 5: Inspect your new county attribute table. Compare and contrast the auto-calculated 
shape area (sq.m) of Cook County, IL against the given GEODESIC area of (sq.km) of Cook County, IL. 
 
 
 
Use Export > Feature class to feature class to export the flight lines in your shapefile  
directRoutes.shp  to make new line features in your geodatabase. Name your output line 
feature class connections. 
 
New shape attributes values will be calculated automatically.  Add your geodatabase polyline feature 

class as a layer to your Map for previewing data map. 
 
 
 
Question 6: Preview your new connections attribute table. What are the perimeter (Shape_Length) 
and area (Shape_Area) values for the Harrisburg to Denver connection?   
 
 
 
Use Export > Feature class to feature class to export the airports in your shapefile  
airports.shp  to make new point features in your geodatabase. Name your output point feature 
class airports. 
 

Add your geodatabase point feature class as a layer to your Map for previewing data map.   
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Obj 3. Prepare your attribute tables to store calculated values.  
 
To keep track of how your auto-calculated Shape_Length and Shape_Area values get distorted 
during projection, we need to add some new fields to our attribute table that don’t get auto-
recalculated during geoprocessing. 
 

Right-click your county layer to open its Attribute Table.  Next, find  Table > View > Fields.  If you 
followed all the instructions properly, then your Fields window should look exactly like Figure 2 
(sans arrows). 

 
 

 
Figure 2. Fields dialog box. 
 
 
 
Add a new field.  Click into the empty box in the Field Name column and start typing the word 
“areaALBERS”.  Under the Data Type column choose the Double data type, which will let the field 
hold large numbers with decimals. Save your change.  
 
 
 
Next, add nine more fields (see Table 1). Save. 

 
  

The coordinates in mapunits 
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Table 1.  The ten new fields we’re adding to the county polygon attribute table. 
 

Field name Data type 
areaALBERS double 

distortALBERS double 
areaHIA double 

distortHIA double 
areaMNC double 

distortMNC double 
areaILE double 

distortILE double 
areaUTM13N double 

distortUTM13N double 

 
When you’ve Saved your table edits, your Field properties should look like Figure 3.  Look at your 
attribute table again to verify that your new fields were added.  If your new fields are filled with 
NULL values, then you’re doing things correctly.  If you new fields are filled with zeros, however, 
then you haven’t (yet) learned the difference between shapefile format and geodatabase format.   
 

 
Figure 3. New fields in the attribute table. 
 

Save your project. 
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Right-click your connections layer to open its Attribute Table.  Next, find  Table > View > Fields.  
Add the ten new fields listed in Table 2. 
 
Table 2.  The new fields we’re adding to the connections attribute table. 
 

Field name Data type 

lengthALBERS double 

distortALBERS double 

lengthHIA double 

distortHIA double 

lengthMNC double 

distortMNC double 

lengthILE double 

distortILE double 

lengthUTM13N double 

distortUTM13N double 

 

Save your edits.   Save your project. 
 
Last, Preview your line attribute table again to double-check your work.  You should see a lot of new 
NULL values because nothing has been calculated yet. 
 

Right-click your airports layer to open its Attribute Table.  Next, find  Table > View > Fields.  Add 
the five fields listed in Table 3. 
 
Table 3.  The new fields we’re adding to the airports attribute table. 
 

Field name Data type 

northAlbers long integer 

northHIA long integer 

northMNC long integer 

northILE long integer 

northUTM13N long integer 

 
Save your edits.  Last, Preview your point attribute table again to double-check your work.  You 
should see a lot of NULL values. 
 
Congratulations!  You just finished preparing your data for analysis. Close [x] all your attribute tables 

and Close [x] the map called Map for previewing data.  Save your project. 
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Obj. 4.  Calculate the distortions that are created during map projection. 
Your project should have six maps.  Open the map called “USAsystem – Albers Equal Area method” 
(Figure 4).  All the data you see are shown using the software’s default rectangular map projection. 
Notice how all the lines of latitude do not converge at the poles as they should.  Notice how 
distorted Antarctica looks.  Notice how stretched things look across the northern latitudes.  Notice 
how Russia has been torn into two pieces. 
 

 
Figure 4: The ugly default rectangular projection. 
 
Add your airports, connections, and counties as the 1st, 2nd, and 4th layers (Figure5), respectively. 
 

 
Figure 5. Airports, connections, and counties added as new layers.  Notice the Drawing Order. 
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US mapping system – Albers Equal Area projection method 
Right-click your “USA system – Albers Equal Area method” map to access its Properties…, then 
select the Coordinate Systems tab.  You’ll notice that the Current coordinate system is set to 
“GCS_North_American_1983”, which is the Geographic Coordinate System (GCS) used to spatially 
reference locations on the “GRS_1980” ellipsoid.  
 
You can project all the data in your map by changing the Current coordinate system or importing a 
new one (Figure 6).  Import… the coordinate system that’s stored in the projection file named 
“NAD83 Contiguous USA Albers Equal Area.prj”.  Applying this system will cause your 
data to be re-projected on screen.  This particular instance of the Albers projection method was 
customized for the contiguous 48 states. 
 

 
Figure 6.  Projecting your data via the Data Frame Properties dialog box. 
 
 
Next, open the airports attribute table.  Right-click the northALBERS field to access the 
Calculate Geometry tool. 
 
Calculate the “Y Coordinate of Point” in using the “Coordinate System of the Current Map.”  You 
should now see the projected northing coordinates for these geographic points after they’ve been 
plotted on this metric mapping system. 
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Right-click the northALBERS field to sort your northing values in descending order. 
 
Question 7: On the USA mapping system, which three airports were projected as the three 
northernmost airports? 
 
 
 
Close the airports table and open the connections attribute table.   
 
Right-click the lengthALBERS field to access the Calculate Geometry tool.   
 
Calculate the “Length” of each feature in “Nautical miles (United States)” using the “Coordinate 
System of the Current Map.”  You should now see the projected lengths. 
 

Right-click the distortALBERS field to access the Calculate Field tool. 
 
Calculate the amount of distortion in your flight lines using Equation 5: 
 

!lengthALBERS! - !GEODESIC_L!    Eq. 5 
 
Right-click the distortALBERS field to sort your values in descending order. 
 
Question 8: On this US mapping system, which connection suffered the most inflation?  The least 
distortion? The most deflation?  Use your data to support your answer. 
 
 
 
Next, close the connections table and open the county attribute table.  Right-click the 
areaALBERS field to access the Calculate Geometry tool. 
 
Calculate the “Area” of each feature in “Square kilometers” using the “Coordinate System of the 
Current Map.”  You should now see the projected areas of these polygons. 
 
Right-click the distortALBERS field to access the Calculate Field tool. 
 
Calculate the amount of areal distortion in your projected counties using Equation 6: 
 

!areaALBERS! - !GEODESIC_A!    Eq. 6 
 
Right-click the distortALBERS field to sort your values in descending order. 
 
Question 9: On this USA mapping system, which county area suffered the most inflation?  The most 
deflation?  The least distortion?  Use your data to support your answer. 
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Okay – we’re done making calculations using this map, so you can close your attribute tables.  Now 
we want to visualize the pattern of projected polygon distortions. 
 
Right-click the county layer to access the Symbology tab. 
 
Use Import Symbology … to import the symbols stored in the layer file named 
countyAreaDistortions.lyrx (Figure 7).  
 

 
Figure 7. Importing symbols stored in a layer file. 
 
Set both the Source Field and the Target Field = areaALBERS and set the Normalization Field 
= GEODESIC_A.  [Run] 
 
If you did everything right so far, then every county on your map should be symbolized with a light 
yellow hue.  If everything is yellow (i.e., every county suffered minimal areal distortion), then 
congratulations!  Close your map.  Save your project. 

If not, then go back to the brown paper airplane on page 10 and try again. 
 

   
If you need a break, then this point is a natural break in the lab. 
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HIA mapping and coordinate system – Azimuthal Equidistant projection method 
Open your “HIA system” map.  
 
Right-click your “HIA system” map to access its Properties…, then select the Coordinate System 
tab.  You’ll notice that the Current coordinate system is “GCS_North_American_1983”, which is used 
to reference locations on the “GRS_1980” ellipsoid.  
 
You can project all the data in your data frame by changing the Current coordinate system of your 
data frame (Figure 6).  Import… the coordinate system that’s stored in the projection file named 

“NAD83_Harrisburg_Intl_Airport_metric.prj”.  Applying the Azimuthal Equidistant 
projection method will change how your data are projected on screen.  This particular instance of the 
Azimuthal Equidistant projection method was customized for the control tower at Harrisburg 
International Airport. 
 
Next, open the airports attribute table.  Right-click the northingHIA field to access the 
Calculate Geometry tool. 
 
Calculate the “Y Coordinate of Point” using the “Coordinate System of the Current Map.”  You 
should now see the new projected northings of these geographic points. 
 
Right-click the northingHIA field to sort your new northing values in descending order. 
 
 
Question 10: On the HIA-centered mapping and coordinate system, which three airports were 
projected as the three northernmost airports? 
 
 
Next, close the airports table and open the connections attribute table.   
 
Right-click the lengthHIA field to access the Calculate Geometry tool.   
 
Calculate the “Length” of each feature in “Nautical miles (United States)” using the “Coordinate 
System of the Current Map.”  You should now see the new projected lengths after they been 
projected onto the HIA mapping system. 
 

Right-click the distortHIA field to access the Calculate Field tool. 
 
Calculate the amount of distance distortion in these flight lines using Equation 7: 
 

!lengthHIA! - !GEODESIC_L!    Eq. 7 
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Right-click the distortHIA field to sort your values in descending order. 
 
Question 11: On the HIA mapping and coordinate system, which connection length suffered the most 
inflation?  The most deflation?  Use your data to support your answer. 
 
 
 
Next, close the connections able and open the county attribute table.  Right-click the areaHIA 
field to access the Calculate Geometry tool. 
 
Calculate the “Area” of each feature in “Square kilometers” using the “Coordinate System of the 
Current Map.”  You should now see the new metric areas of these polygons after they’ve been 
projected onto the HIA mapping and coordinate system. 
 

Right-click the distortHIA field to access the Calculate Field tool. 
 
Calculate the amount of areal distortion in these flight lines using Equation 8: 
 

!areaHIA! - !GEODESIC_A!    Eq. 8 
 
Right-click the distortHIA field to sort your values in descending order. 
 
Question 12: On this HIA mapping and coordinate system, which county suffered the most inflation?  
The most deflation?  The least distortion?  Use your data to support your answer. 
 
 
 
Okay – we’re done making calculations in this map, so you can close your attribute tables.  Now we 
want to visualize the pattern of county polygon area distortions across the county. 
 
Right-click the county layer to access the Symbology tab. 
 
Use Import Symbology… to import the same symbols stored in the same layer file named 
countyAreaDistortions.lyrx.  
 

Set both Value Fields = areaHIA and set both Normalization Fields = GEODESIC_A.  [Run] 
 
If you did everything right so far, then every county on your map should NOT be symbolized with a 
light yellow color.  You should see a projection that preserved geodesic distances from Harrisburg, 
yet increasingly distorted shape areas as distance from Harrisburg increases. 
 
If yes, then congratulations!  If no, then go back to the blue paper airplane on page 13 and try again. 
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Minnesota’s Central mapping zone – Lambert’s Conformal Conic projection method1 
 
Open your “State Plane zone MN-C” map.  
 
If you successfully completed the work in the first two map, then you’ve probably recognized the  
workflow for the rest. 

a. Project all the data in your map by changing the map’s coordinate system. 
b. Calculate new geometric attributes based on the current map’s coordinate system. 
c. Calculate the amount of distortion to see what got messed up where. 
d. Symbolize the county polygons to reveal the national distortion pattern. 

 
Use the instructions I provided for the HIA system as a guide for processing the data for Minnesota’s 
Central mapping zone. Just be sure to substitute “MNC” every time you see “HIA” in the 
instructions. 
 
 
Question 13: On the mapping and coordinate system for Minnesota’s Central Zone, which three 
airports were projected as the three northernmost airports? 
 
Question 14: On the mapping and coordinate system for Minnesota’s Central Zone, which connection 
suffered the most inflation? Least distortion? The most deflation?  Use your data to support your 
answer. 
 
Question 15: On the mapping and coordinate system for Minnesota’s Central Zone, which county 
area suffered the most inflation?  The most deflation?  The least distortion?  Use your data to support 
your answer. 
 

 
Illinois’ East mapping zone – the transverse cylindrical Mercator projection method 
 
Open your “State Plane IL-E” map.  
 
Question 16: On the mapping and coordinate system for Illinois’ East zone, which three airports were 
projected as the three northernmost airports? 
 
Question 17: On the mapping and coordinate system for Illinois East, which connection length 
suffered the most inflation?  The most deflation?  Use your data to support your answer. 
 
Question 18: On the mapping and coordinate system for Illinois East, which county area suffered the 
most inflation?  The most deflation?  The least distortion?  Use your data to support your answer. 

                                                        
1  Why Minnesota’s Central mapping zone?  Because that’s the zone that Bolstad (2016) discusses on pages 126-127. 
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UTM zone 13 N  – a different instance of the transverse cylindrical Mercator projection 
method but customized for a much larger zone 
 
Open your “UTM Zone 13N” map.  
 
Question 19: On the mapping and coordinate system for the global UTM system’s zone 13N, which 
three airports were projected as the three northernmost airports? 
 
Question 20: On the mapping and coordinate system for UTM Zone 13N, which connection length 
suffered the most inflation?  The most deflation?  Use your data to support your answer. 
 
Question 21: On the mapping and coordinate system for UTM Zone 13 N, which county area suffered 
the most inflation?  The most deflation?  The least distortion?  Use your data to support your answer. 
 

 
Final layout and final questions 
Close all of your maps and open the one Layout in this project.  You should see five of your six maps, 
one symbol key (shared by all five maps), and a little abstract.  
 
Make it easier to compare apples-to-apples by changing the extent (pan) and map scale (zoom level) 
of each map frame so that they’re all showing the same stuff at the same scale.  You could, for 
example, right-click each connections layer and Zoom to layer.    
 
Question 22a: The latest population estimate for Cook County, IL, is 5,211,263 people.2   
So, if you need to calculate the population density [Eq. 4] for Cook County, then which of your five 
projected polygons would give you an accurate result?  Which mapping systems would lead you to 
overestimate population density? To underestimate it?  Report and explain your results, andyou’re 
your calculated population densities to support your claims. 
 
 

Given the long length of this lab and the relatively large number of questions, I am not 
requiring a complete written report for this lab.  Instead, I’ve given you a map layout to print (on 
tablet size paper – 11” x 17”) and a worksheet to complete.  You should see lines or boxes for each 
question listed above.  Staple the printed layout behind your answer sheet before submitting them. 

 

                                                        
2  Source: U.S. Census Bureau. 2018. Population estimates, July 1, 2017. Last accessed on March 23, 2018 at 
https://www.census.gov/quickfacts/fact/table/cookcountyillinois/POP060210  

 

https://www.census.gov/quickfacts/fact/table/cookcountyillinois/POP060210

